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Introduction

Ireland (IRE) Address Data Information

Dataset Code:
Approximate Data Size:
Data Source:

Update Frequency:

Expiry:

Page 4|Data Guide—Ireland (IRE)

IRE
150MB
Capita and Experian
The quarterly data release dates are:
e February
e May
e August
e November
Data files will expire 13 months after creation. Forexample, February data will
expire in March of the following year.
Ensure every data update is applied promptly, otherwise the data may expire
and the product will become unusable.
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List Of Available Data Files

File

Extension File Type Comment
.dts Dataset Main address data.
.zIx Single Line Index Indexing data for use with Single Line searching.
File
tpx Typedown Index Indexing data for use with Typedown searching.
File
.dap DataPlus Set DataPlus data.See page 10 for more information about the available

DataPlus sets.

Page 5|Data Guide—Ireland (IRE)
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About This Data

This chapter provides detailed information about the IRE dataset.

Area Covered

The IRE dataset covers to premises level all counties under the administration of the Republic of Ireland.

Address Elements

The following address elements are stored within the IRE data files.

Address Element

Organisation

Department

Building Number

Building Name

Sub Building Name

Sub Building Number

Secondary Thoroughfare
Secondary Thoroughfare Name

Secondary Thoroughfare Descriptor

Gaelic Secondary Thoroughfare

Primary Thoroughfare

Primary Thoroughfare Name

Primary Thoroughfare Descriptor
Gaelic Primary Thoroughfare
Building Group

Building Group Name

Building Group Descriptor
Gaelic Building Group
County **

County Prefix

County Name

PNR County **

PNR County Prefix

PNR County Name

Gaelic County **

Gaelic PNR County **
Posttown

Resident Preferred Posttown
Gaelic Posttown
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Example
Experian Ltd
Sales

52
Rosebank
Apartment

1

Dublin Road Dublin Road

Bothar Atha Cliath

Francis Street Francis Street

Sraid San Proinsias

Saint Canice's Court Saint Canice’s
Court

Cuirt Chainnigh
Co Sligo
Co

Sligo

Co Cork
Co

Cork
Sligeach
Corcaigh
Portlaoise

T

Port Laoise

Element Code
O11
021
P11
P12
P21
P22

S11 8111 S112

S12

S21 8211 S212

S22

S31 8311 S312

S32
L11
L111

L112

L12
L121
L122
L13
L14
L21
L22
L23
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Examples of addresses that include both primary and secondary localities

Address Element Example Element Code
Gaelic Resident Preferred Posttown T L24
Secondary Locality Castletroy L31
Gaelic Secondary Locality Caladh An Treoigh L32
Primary Locality Ballinla L41
Gaelic Primary Locality Béal An Atha L42
Eircode D02 AF30 C11
Country * Ireland X11
Two character ISO country code * IE X12
Three character ISO country code * IRL X13

* Elements that only appear in the address if their position is fixed.

** Only one of the L11 or L12 elements (and only one of the corresponding Gaelic L13 or L14 elements) will be populated,
depending on whether the County name is the same as the county town. See "Postal Code Structure"” on page 8

T This element is the same as L21 (L23 for Gaelic addresses) unless the resident prefers the posttown to be dropped, in
which case it is blank.

Townland is not an address element in the IRE data. Instead, townlands are aliases of the Primary Locality
element; see "Townlands" on page 8

Address Element Definitions

Localities
The Ireland (IRE) dataset also contains posttown and townland information.

Jennings Plant Hire In this address, Feagh is the primary locality and Tiermaclane is the secondary
Carla House locality

Feagh

Tiermaclane

ENNIS

Co Clare

1 The Terrace In this address, Nadd is the primary locality and Banteer is the secondary locality.
Nadd

Banteer
Co Cork
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Posttowns

The posttown is the town or postal district associated with the premises for postal delivery purposes.

If the posttown is the same as the county town, the County is not returned in any of the standard forms of address
(see "Forms Of Address" on page 7). The PNR County is returned in the Resident Preferred forms of address if the
posttown is dropped from the final address.

For example, if an address is in "Cork, Co Cork", "Co Cork" will be dropped from the final address. If you want to
ensure that the County is always returned, you should fix both the County element and the PNR County element to
your layout, since only one will be populated. Refer to your product documentation for information about fixing
elements.

Townlands
The townland is the lowest-level officially-defined geographical unit of land.

Townlands are not elements in the data; they are stored as aliases in the Primary Locality element. They will only be
returned in addresses if a layout based on a Resident Preferred form of address is being used (see "Forms Of Address"
on page 7)and the townland was included in the input address.

Postal Code Structure
Postal codes are not currently used in Ireland for mail sorting and routing.

Dublin is divided up into numbered areas, for example Dublin 1. These area numbers run from 1 to 24, with the
exception of 19, 21, and 23 which do not exist. Odd numbers represent districts North of the river Liffey and even
numbers represent areas to the South of the river. There is also an area called Dublin 6W.

These areas can be abbreviated in Typedown and Single Line searches as, for example, D1 and D6W.

Diacritics

The Gaelic language address elements often contain diacritic characters. These entries also have aliases stripped of the
diacritics, so your search results will be identical whether or not you include diacritic characters in your search criteria.
For example, A will be matched to A, o will be matched to 6, etc.

You can choose whether to return output addresses in a format which includes diacritics by enabling or disabling
the Flatten Diacritics checkbox on the Pro Configuration Editor, or the oEMCharacterset and FlattenDiacritics
settings in the configuration files. For more information refer to your product documentation.

Forms Of Address

[Forms of address are referred to as Country Views in Pro version 6 and earlier. J

There are four forms of address stored in the IRE data files:

- ECAD (English)
- Resident Preferred (English)
- ECAD (Gaelic)

- Resident Preferred (Gaelic)

Page 8| Data Guide—Ireland (IRE)
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The Gaelic versions of the forms of address are alternative language versions which work in the same way as the
English forms. On occasions when a Gaelic form of address is selected and no Gaelic equivalent exists foran address
elementin the data, the English version will be returned.

The form of address determines which address elements are used in the returned address. County, Posttown,
Secondary Locality and Primary Locality are examples of address elements which vary according to the form of

address selected.

ECAD (Eircode Address Database)

The format of an Irish address depends on whether there is a Building Group in the returned address. The official
ECAD (Capita) address is made up from the following elements:

Address with Building Group

[Personal Name]*
[Department]

[Organisation]

[PO Box]*

[Sub Building Name/Num][Building Name]
[Building Number][Building Group]
[Primary Thoroughfare]

[Secondary Thoroughfare]

[Locality]

[Secondary Locality]

[POSTTOWN]

[County]

Address without Building Group

[Personal Name]*
[Department]

[Organisation]

[PO Box]*

[Sub Building Name/Num][Building Name]
[Building Number]

[Primary Thoroughfare]

[Secondary Thoroughfare]

[Locality]

[Secondary Locality]

[POSTTOWN]

[County]

* Denotes address lines containing elements not included in the IRE dataset.

Note that the County name is not required when it is the same as the Posttown. Many addresses in rural areas have no

thoroughfare or premises information.

Resident Preferred

In Ireland, the way residents prefer to write their addresses commonly differs from the official ECAD format. This

occurs for one of the following reasons:

- Unexpected Posttown
- Dublin Periphery

- Bordering Localities

Page 9|Data Guide—Ireland (IRE)
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Unexpected Posttown

In rural areas the posttown for an address can be a significant distance away from the actual premises. In these
cases, and especially when the posttown is in another county, a resident would not expect the posttown to be
included in the address. Pro does not return these unexpected posttowns when a Resident Preferred form of
address is selected.

For example, the unexpected posttown "ENNISCORTHY" is not present in this address when a Resident Preferred form
is selected:

Language ECAD Form Resident Preferred Form
English Coolnagree
Adamstown Adamstown
ENNISCORTHY Co Wexford
Co Wexford
Gaelic Cuil na Grai Cuil na Grai
Baile Adaim Baile Adaim

INIS CORTHAIDH Loch Garman
Loch Garman
Dublin Periphery

Resident Preferred forms of address return the county rather than the postal district number for localities on the Dublin
periphery.

[Inner city addresses always return a Dublin postal district number. J

For example, the Dublin district number in this address is replaced by "Co Dublin":

Language ECAD Form Resident Preferred Form
English Barnados

7 Main Street 7 Main Street

Clondalkin Clondalkin

DUBLIN22 Co Dublin
Gaelic Barnados Barnados

7 An tSraid Mhor 7 An tSraid Mhor

Cluain Dolcain Cluain Dolcain

BHAILEATHACLIATH 22 Baile Atha Cliath

Bordering Localities

Premises are sometimes located on or close to the border of two (or more) localities. In these cases, residents
may not want to use the locality where the address is "officially" located, but instead prefer to use the
neighboring primary or secondary locality, or even the neighboring county name. The Resident Preferred
forms of address will return a bordering locality instead of the official one only when the bordering locality
was included in the input address.

The English example below assumes the bordering primary locality "Montpelier" was included in the input address. The
ECAD forms revert to the "official" locality, but the Resident Preferred forms retain it as a valid bordering locality:
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Language ECAD Resident Preferred
Form

English Carob Cottage Carob Cottage
Derryhasna Mon'fpeller.
O’Briensbridge o Br|.enst.)r|dge

. Co Limerick

Co Limerick

The Gaelic example below assumes the bordering primary locality "Baile an Locha" was included in the input address.
The ECAD forms revert to the "official" locality, but the Resident Preferred forms retain it as a valid bordering locality:

Language ECAD Resident Preferred
Form
Gaelic ;
Al (5L Amber Hil
An Eaglais Baile an
An Carraigin Locha An
PORT LAIRGE Carraigin Cill
Cill Chainnigh Chainnigh

About DataPlus Information

You can configure your Experian Data Quality products to use the DataPlus sets that are available for IRE data.
Please refer to the relevant section of the product documentation for information on configuring Experian Data Quality
products to return DataPlus information.

Each DataPlus set is divided into one or more items. Experian Data Quality products can be configured to return
these items via the Configuration Editor (using the element name) or the configuration file(using the code name).
This section details the DataPlus sets currently available for IRE address data.

DataPlus Sets for IRE Address Data

The following DataPlus sets are available with IRE Address Data:

- Ireland Address
- Ireland Mosaic

The supplier for Address DataPlus is ECAD, a collaboration between Capita and Ordnance Survey Ireland (OSI).
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Ireland Address

Identifier: IREADD

The IREADD DataPlus set provides additional information about some elements of the returned

address. The IREADD DataPlus set contains the following elements:

Element Code Description

Building Group BGrTypeName Building group type name, for example, shopping centre, or educational campus.
Type Name The data has limited coverage; this field is not populated for most addresses.

Ireland Mosaic
Identifier: IREMOS
The IREMOS DataPlus set returns IRE MOSAIC demographic data relevant to a given address.

IRE MOSAIC information is obtained primarily from the Census, but other (anonymous) third party
data sources are also used. The data enables marketeers to predict the type of people living at a
given address.

Updates are supplied to Experian Data Quality annually but only account for changes in
GeoDirectory data. Historically, the MOSAIC data is only re-clustered after each Census (every
five years). In the future, given the increase in sources of data used to create the MOSAIC
classification, updates may be more frequent.

The IREMOS DataPlus set contains the following elements:

Element Code Description

MOSAIC Group GrpCode MOSAICGroupCode
MOSAIC GroupName GrpName MOSAIC Group Name
MOSAIC Type TypeCode MOSAICType Code
MOSAICTypeName TypeName MOSAICTypeName
MOSAIC Area AreaCode MOSAIC Area Code
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Using This Data

This chapter provides search tips and other product-specific information when using Pro, Pro Web, or Batch.

These searches are accurate at the time of data release. However, search results may differ depending on the
data release you are using.

With Pro

Ireland (IRE) Address Layouts

Forms of Address

The Ireland (IRE) dataset includes several forms of address, as described on page 7. The default layout will return
addresses in the default form of address. If you want to return addresses in a different form you must set up
additional address layouts.

[Forms of address are referred to as Country Views in Pro version 6 and earlier. J

Adding Layouts

Additional layouts are set up using the Configuration Editor. Once saved, new layouts can be activated after you
restart Pro. You can set up layouts in the Configuration Editor with the following steps:

1. In the Configuration Editor Layout Manager, double-click on Ireland. This expands the list of layouts that are set up.

2. Click on the New layout button on the toolbar. Alternatively, from the Layout menu, click New, or right-click
Ireland and choose New from the menu.

A dialog opens listing the available forms of address.

3. Select the form of address you want to add and click OK. The new layout is added to the bottom of the layout
list.

4. Rename the new layout. For example, if you added a layout based on one of the Gaelic language forms, you
might rename the layout "Gaelic". You can rename the layout at any time by right-clicking it in the list and
selecting Rename from the menu.

5. You can assign a hotkey for the new layout. When Pro is minimized, using a layout-specific hotkey will pop
up the program and automatically select that layout.

To assign a hotkey, click on the Hotkey field in the Layout Properties pane and press the keys you want to assign.
For example, if you have added a Gaelic layout, click in the Hotkey field and press CTRL+ G. When Pro is
minimized, this hotkey pops up Pro in your Gaelic layout.

It is recommended that you do not choose a hotkey that is already in use by Pro (see the "Available
Keystrokes" topic in the Pro Help). You should also avoid common hotkeys, for example, CTRL + A, which
in many Windows applications means "Select All".

For more information about hotkeys, see the Configuration Editor Help.

6. Save the changes you have made in Configuration Editor by clicking the Save button in the toolbar, or clicking
Save from the File menu, or pressing CTRL + S.

7. Close the Configuration Editor. The changes you have made will not take effect until you have closed and restarted
Pro.
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Changing Layouts

You can change the current layout in Pro by clicking Select Layout... from the View menu or pressing CTRL+ L. The
Select Layout dialog opens. Choose the required layout from the list.

You can change the layout at any stage of your search. To see a final returned address in a different layout, click Select
Layout... from the View menu, or press CTRL +L, and click the layout.

If you drag the Select Layout dialog to the side of Pro,you can preview the differences to the returned
address as you browse different layouts.

Search Examples: Typedown

Qe Hﬁﬁ B | Dataset: IIreIand [.j
Enter locality or Dublin area code

I Select I

The following table provides a list of these example search types:

- Full addressknown
- Primary and secondary locality not known

- Gaelic language addressknown

Search type Example
Full address 1. Enter the locality, knocknacarra, and press Enter.
known 2. Enterthe firstfew letters of the street name, for, and press Enter. In this example for is enough

touniquely identify ForestHillsasthere are no other streets beginning"For...".
3. Enter thepremisesnumber, 8, and pressEnter. The correct address is returned:

8 Forest Hills
Knocknacarra
Co Galway

Primary and 1. Enterthe county, co kildare, and press Enter.
secondary locality 2. Enter the firstfew letters of the street name, shed, and press Enter.
not known 3. Enter the premises number, 632, and press

Enter. The correct address is returned:

632 Shed

Road

Levitstown

Maganey

Co Kildare
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Search type Example

Gaelic language 1. Enter the locality, inis, and press Enter.

address known 2. Enter the street name, coillnagcoll,and press Enter. Note that the street name is

displayed in both Englishand Gaelic in the picklist, whereas the locality is only displayed in

Enter street name
Icoil na geoll

FE@ Inis
m

3. Enter the premises number, 3, and press Enter.

The correct address is returned, according to the layout selected. The default layoutwill
return addresses in the Resident Preferred (English) form of address:

3 Hazelwood

Ennis

Co Clare

Search Examples: Single Line

e | e; la & | Dataset: Ilreland j

Enter search

j Search |

The following table provides a list of these example search types:

Full addressknown

Only street name known
Gaeliclanguage address known
Character missing from address
Address contains spelling mistake
Incomplete address element(partial)

Incomplete address element(tagged)

Search type Example
Full address known Enter the premises details and the street name followed by the locality: apartment 7,main
st,borrisokane
Thecorrectaddressis returned: Apartment 7
Main Street
Borrisokane Co Tipperary

Primary and secondary

) If only the street name is known, entering the street will return a picklist from
locality not known

which the correct one can be selected. Pro can handle abbreviated street
descriptors such as st, rd, ave or cl.

Enter church ave to view a list of every street called "Church Avenue" in the
country.
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Search type Explanation
Gaeliclanguage Inthisexample youare searching on a full Gaeliclanguage address:
address known 11 an fhaiche,inis,anclar

The correctaddressisreturned, according to the layoutselected. The defaultlayoutwill return
addresses in the Resident Preferred (English) form of address:
11 The
Green
Lifford
Road Ennis
Co Clare
Character missing from  |fone or more characters are missing from the address the unknown characters canbe
address replaced with a questionmark.
Enter5?untersave,fi?house and the correct address is
returned: 5 Hunters Avenue
Hunters Wood
Firhouse DUBLIN 24
Address contains Entering an address that contains one or more spelling errors can stillreturn the correct
mistake address. Entering 196 few vale,shankhill will still return the correct address:
196 New Vale
Shankill
Co Dublin
Incomplete (partial) Ifyouonly have partialaddressinformation, youcan replace the remainderof anaddress
element address element with an asterisk.
Entering chapel*,co cork will display a picklist of streets beginning "Chapel" in County Cork.

Incomplete address

element (tagged) Sometimes it is helpful to tag a part of the search string to let Pro know which part of

the address it is. For a list of available search constraints, see Search Constraints
below.

Searching on bally*@s,carlow, will display a picklist of streets that begin with "Bally..."
in Carlow.

Search Constraints

The following search constraints can be used to restrict searches when using the Single Line search engine in Pro
or Batch Interactive.

Constraints Elements Restricted to Example

@C County dublin@c

@T Posttown 10 main street,cork@t
@S Secondary Thoroughfare, abbey*@s,clonmel

Primary Thoroughfare

@P Building Name/Number, Sub garden*@p,wicklow
Building Name/Number
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With Pro Web

The Ireland (IRE) dataset contains several forms of address, as described on page 77. Pro Web integrations can be
configured to use address elements relating to any form of address. Refer to your Pro Web
documentation for configuration instructions.

An example of how forms of address can be configured with address layouts in Pro is provided on page 13.

Scenarios

The following table indicates the relevant search examples for each Pro Web scenario and search engine that
supports IRE address data.

Scenario Search Engine For example, see:

Address Capture on Single Line Hierarchical SingleLine searchexamplesonpage 15.

the Intranet

Address Capture on Single Line Flattened SingleLine searchexamplesonpage 15.

the web

Address Capture Single Line Flattened SingleLine searchexamplesonpage 15.

Single Line Single Line Hierarchical SingleLine searchexamplesonpage 15

Standard Typedown Typedown examples on page 14.
Single Line Hierarchical Single Line search examplesonpage 15.

ActiveX Control Typedown Typedown examples on page 14.
Single Line Hierarchical Single Line search examplesonpage 15.
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With Batch

If you are using Batch to clean your database against more than one dataset, DataPlus information cannot
be configured.

This section details the information relevant to using Batch with Ireland (IRE) address data.

Licenses

An Post require the use of ECAD data to be charged on a per-record basis when using Batch. Your license for the
IRE dataset willbe a metered license. 'Clicks' are counted against the meter when you process your database, and
these must be activated before you can output results from Batch. Refer to your Batch documentation for more
information about metered licenses, activating clicks and increasing the clicks available on your meter.

Forms of Address

Thelreland (IRE) dataset contains several forms of address as described on page 7. You can configure Batch
Standalone to return addresses using a particular form during session configuration. Refer to your Batch
documentation for more detailed instructions.

Batch APl integrations can be configured to use address elements relating to any form of address. Refer to your
product documentation for address layout configuration instructions.
Dataset-Specific Input Field Types

When you are configuring a Batch session, you can specify the address elements which are contained in your input
fields. This can speed up the cleaning process as Batch does not have to work out which address element is
contained within a field.

There are no dataset-specific input field types defined for Ireland (IRE) data. Only the generic input fields
(Organisation, Place, Country, etc.) are available.

Dataset-Specific Filters

Batch provides a number of default filters to use when viewing, exporting or committing the results of a session.
When using the Ireland (IRE) dataset, you can use the Ireland Chargeable Records filter to export or commit only
those records which you will be charged for under the terms of your An Post license. See "Licenses" (above) for
more information about these terms.

Dataset-Specific Information Bits

IRE-Specific Information Bits
When using IRE data, a selection of dataset-specific information bits can be returned.

- For Standalone users, IRE-specific information bits are returned as the first 8 digits of the 16-digit extended
match result as displayed in Interactive.

- For API users, these are returned by the function QABatchWV_GetMatchInfo as parameter riCountryinfo1, and from
the function QABatchWV_Clean in the parameter rsReturnCode from the 13th to 20th characters. Refer to the
Batch manual for further information about these functions.

The following table provides a full list of IRE-specific information bits that can be returned.
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Information Bit Description

10000000 English Primary Locality added that was not supplied in the input address
20000000 Gaelic Primary Locality added that was not supplied in the input address
40000000 English Secondary Locality added that was not supplied in the input address
80000000 Gaelic Secondary Locality added that was not supplied in the input address
01000000 Street retained from the input address that is not in the data

02000000 Street added that was not supplied in the input address

00100000 Match to bordering locality

00200000 Match to bordering Dublin district number

00400000 Wrong Dublin district number supplied

00800000 Match to bordering county

00020000 Posttown added

00001000 Gaelic Primary Thoroughfare available

00002000 Gaelic Secondary Thoroughfare available

00004000 Gaelic Primary Locality available

00008000 Gaelic Secondary Locality available

00000100 English Posttown has been removed

00000200 Gaelic Posttown has been removed

00000400 English Resident Preferred Posttown has been removed

00000800 Gaelic Resident Preferred Posttown has been removed

00000010 Non-trivial change applied as a result of referencing Capita data

Search Examples: Batch Interactive

For information about the best methods for searching on Ireland addresses using Batch Interactive please refer to
Single Line search examples on page 15 and Typedown search examples on page 14.
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